Entwurt und Test eines Minimalsystems

11. November 2014

Zusammenfassung
In dieser Schritt-fiir-Schritt-Anleitung wird mit EDK ein minimales Rechnersystem
konfiguriert, die erforderlichen Datein fiir die Programmierung der Rechnerhardware in
den Logikschaltkreis und die Programmeintwicklung erzeugt. Dann wird SDK gestartet,
die Projektumgebung eingerichtet, ein kleines Programm zum Ausprobieren der Hardware
erstellt und mit diesem der entworfene Rechner ausprobiert.

1 Das zu entwerfende System

Abb. 1 zeigt die Blockstruktur des zu entwerfenden Rechnersystems. Es besteht aus dem Prozes-
sor, einem {iiber lokale Speicherbusse (LMB’s) und entsprechende Controller angeschlossenen
Dualport-Speicher fiir die Befehle und Daten, einer iiber den AXI-Bus angeschlossene Aus-
gabgeschnittstelle fiir die Ansteuerung der Leuchtdioden auf der Baugruppe, einem iiber den
AXI-Bus angeschlossenen Debug-Controller und einer Riicksetzschaltung. Zum besseren Ver-
stdndnis sind im Veranstaltungsskript die Abschnitte ## durchzuarbeiten.

Takteingang Prozessor Businstanzen Schnittstellen-Controler Speicher
Microblaze (Prozessor) Imb_v10 lmb_bram_if_cntlr bram_block
DLMB = ~{SYS_RST LISLMB  BRAM_PORT o PORTA
+—{ LMBCLK
Clk CLK ———
mb_v ;
ILMB — 1 Imb_bram_if_cntlr
e = SLMB BRAM_PORT =~ PORTB
—{ MB_RESET L MBOLK
e Tl EGoTIE axi_gpio (Ausgabeschnittstelle) | Ausginge
M-AXLDP | 1.._ARESETN S_AXI GBIO_I10_0 Led
DEBUG I.. ACLK |—> S_AXI_ACLK
= = L mdm (Debug-Controller)
proc_sys_reset (Riicksetzschaltung) S AXI Debug SYS_Rst
—> Slowes_sync_clk Bus_Struct_Reset
1> Dcem _locked I.._aresetn MDDEBUG.0
S_AXI_ACLK

e MB_Debug_Sys_Rst

Abbildung 1: Das zu entwerfende Rechnersystem

2 Hardware-Entwurf

Der System Builder von EDK ist in der Lage, das System fast vollstdndig zu konfigurieren.
Der Rest ist manuell nachzubessern. Abb. 2 zeigt die Programmoberfliche von EDK und die
auszuwahlende Schaltfliche » New BSP-Project« fiir den Start des System Builders.
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7= Xilinx Platform Studio (EDK_P.68d) - no g - |EI |i|
Fie Edit View Project Hardware Device Configuration Debug =

%@z loser|Eblew|p@lz £ |

Getting Started

}%?3 \/}Create Mewr Project Using Base System Builder

Use the Base System Builder wizard to create an XPS _ILI
«| | b

Abbildung 2: Startoberfliche von EDK

In dem sich 6ffnenden Fenster, Abb. 3, ist die Projektdatei und » AXI-System« auszuwéhlen.
Fiir jedes neue Projekt sollte ein eigenes Verzeichnis angelegt werden, was auch innerhalb des
Meniis moglich ist. Die nicht gezeigten Auswahlfenster in der Abbildung darunter bleiben leer.

Weiter mit » Ok«.

%> Create New PS Project ing BSB ard il
: —Mew Project
Project File |H:'\Softprnzessnr\BSP_A}(I_Base\system.mp
—Select an Interconnect Type
! * AXI System

AXIis an interface standard recently adopted by Xilinx as the standard interface used for
all current and future versions of Xilinx IP and tool flows. Details on AXI can be found in
the AXI Reference Guide on xilinx.com.

" PLB System

Abbildung 3: Festlegung des Arbeitsverzeichnisses und der Art des Bussystems

Im néchsten Fenster, Abb. 4, sind auszuwéhlen:

e »Create a System for a Custom Board« (Wir haben keines der auswéhlbaren Boards),
e der Typ des zu programmierenden Logikschaltkreises (spartan6, xc6slx16, ..),

e die Taktfrequenz 100 MHz, die Art des Riicksetzsignals (high-aktiv).

Fiir die nicht gezeigten Eintragsfelder sind die vorgegebenen Werte beizubehalten. Weiter mit
»Next«.
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/i Base System Builder — AXI flow

—Board

" Create a System for the Following Development Board (Pre-selected Device Info)

Board Vendor I.‘(ilinx VI Board Name II(inte.\{-.'rr KC705 Evaluation Platform j Board Revision I?

& Create a System for a Custom Board

—Board Configuration

Architecture Ispar‘tanﬁ VI Device XC6sh16 Reference Clock Frequency |1DD.DD

Package Icsg324 'I Speed Grade |-2 'I Reset Polarity IActive High 'I ™ Use Steppin

—Select a System

Dual MicroBlaze Processor System

Single MicroBlaze Processor System System Information
’7This system consists of one instance of MicroBlaze with external mem

Abbildung 4: Auswahl des Systemtyps und des programmierbaren Logikschaltkreises

Im néchsten Fenster Abb. 5 wird die Blockspeichergrofe festgelegt, kann eine Gleitkom-
marecheneinheit (FPU) und konnen periphere Einheiten wie Speichercontroller, Timer, und
Schnittstellenschaltungen hinzugefiigt werden. Unser Minimalsystem soll nur eine Ausgabe-
schnittstelle fiir die acht Led’s auf der Baugruppe erhalten. Das Hinzufiigen erfolgt iiber » Add
Device«. Die weiterhin erforderlichen Bausteine (Debug-Controller, Prozessor, ...) werden ohne
explizite Auswahl eingefiigt.

/> Base System Builder - AXI flow 2| x|

Processor Frequency |1DD MHz j

— Processor Configuration

~Select a Processor ~ microblaze_0
microblaze_0 Enable Floating Point Unit ™
Local Memory Size |s ke |
Instruction Cache Size [s ke =l
Data Cache Size e ke 2

—Select and Configure Peripherals

Available Peripherals Included Peripherals for microblaze_0 Select All
Add Device...l Export... Import... | Core | T

Peripheral Names
10 Devices Add >
=- Internal Peripherals

- axi_bram_ctrl

- axi_timebase_wdt
- axi_timer

More Info | < Back Finish Cancel

Abbildung 5: Konfiguration des Systems

| LEDS
Core axi_gpio

Data Width E =

< Remove | Use Interrupt r

Nach »Finish« oOffnet sich im linken Fenster der »IP Catalog« und rechts die »System
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Assembly View / Bus Interfaces« (Abb. 6). In diese Ansicht kénnen weitere Komponenten und
Busse aus dem Bausteinkatalog zum Rechnersystem hinzugefiigt und und verbunden werden.
In unserem Projekt hat der »System Builder« bereits alle erforderlichen Bausteile ausgewihlt
und mit den richtigen Bussen verbunden. Wechsel zum Reiter »Ports.

Orfep|lewr@= £
IF Catalo.g «+08 X ALL \+ Bus Interfaces | Ports | Addresses
: }1{ r,é't' EI Name
- axifte_0
= £ EDK Instal - microbbze_0_dimb
& Analog - microblaze_0_imb
& Arithmetic - microblze_0
&- Bus and Bridge - microblBze_0_bram_block
- Clock, Reset and Interrupt & microblaze_0_d bram_cir!
& Communication High-Speed = microblze_0_i bram_ctrl
-- Communication Low-Speed & debug_module
- DMA and Timer & LEDS
& Debug - abck_generator_0
& FPGA Reconfiguration - - proc_sys_reset_0
1 | | 4 —Legend
WMaster #Slave dMaster/Slave B Target <Initiator @ Connected YUnconnected
Search IP Catalog: I Clear | Treroduction (Elicense (paid) (Sllicense (eval) SiLocal &iPre Production
! Superseded Discontinued
& Project @ IP Catalog | « Graphical Design View | & System Assembly View

Abbildung 6: Das konfigurierte System

In der Port-Ansicht, Abb. 7, sind die Eintrége fiir die externen Anschliisse (External Ports)
so noch nicht ganz richtig. Unser Rechnersystem bendtigt zum Testen keinen Reset-Eingang
und der 100MHz-Eingabetakt ist nicht {iber differentielle Eingénge, sondern nur iiber einen
Eingang an den FPGA angeschlossen. Die Ausginge zu den Leuchtdioden soll einfach nur
»Led« heiffen. Der Baustein »clock generator« ist in unserem Beispiel, in dem die Frequenz
des internen Takts gleich der des Eingangstakts ist, eine einfache Verbindung. Dieser Baustein
ist ohne Funktion und soll zur Vereinfachung weggelassen werden.

Name |C0nnected Port | Direction | Range |Class | Frequency(Hz)l
& External Ports

- O N clock_generator_0::CLKIN L1 - CLK | 100000000

- CLK P clock_generator_0::CLKIN 21 - CLK | 100000000

-~ LEDS_ TRL O LEDS::[gpio_0]::GPIO_IO_O fo ~|/0:77 NONE =

proc_sys_reset_0::Ext_Reset_In

r4
clock_generator_0::RST I v RST =

- axiEilite_0

- microbaze_0_dimb

- microbaze_0_imb

- microbaze_0

- microbaze_0_bram_block
- microbaze_0_d_bram_ctrl
- microbiaze_0_j_bram_citr!
- debug_modue

B LEDS

- clock_generator 0

B proc_sys_reset 0

Abbildung 7: Port-Ansicht nach der Konfiguration mit dem »System Builder«

Der einfachste Weg zur Nachbesserung ist, die externen Signale »CLK N«, »CLK P«
und »Reset« sowie den die Taktversorgung »clock generator 0« zu loschen, die Ausginge
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»LEDS TRI O« in »Led« umzubenenen und die dann fehlenden Verbindungen neu zuzuord-
nen. Loschen erfolgt durch Mausklick auf den Eintrag und »Delete external Port« bzw. » Delete
Instance and all its connections« und erfordert etwas Ubung und Geduld. Der neue Taktan-

schluss wird iiber einen Klick auf die Schaltfliche oben rechts erzeugt. In das aufgehende
Menii in Abb. 8 ist der Anschlussnahme, hier »Clk«, die Signalflussrichtung, hier »I« fiir Ein-
gang/Input, und der Signaltyp, hier » CLK« fiir Takt einzutragen. Nach » Ok« ist in der Zeile
fiir den Takteintrag noch die Frequenz zu erginzen (siehe Abb. 9).

/% Connection Dialog x|

External Port Name ICIk

Direction [ |
Class cLk |
Net Mame ||

0K | Cancel |

Abbildung 8: Dialogfenster fiir das Anlegen externer Anschliisse

_ Namensénderungen erfolgen durch Mausklick auf den alten Namen. Auch das erfordert etwas
Ubung und Geduld. Abb. 9 zeigt die fertig gednderten Eintrige fiir die externen Anschliisse.

Name Connected Port | Direction | Range | Class | Frequency(Hz) | Differential Polarity
=i External P...

L1 - CLK ~| 100000000
~led  LEDS:[gpio_0]:GPIO_I0_0 # O ~| [0:7] NONE -
Abbildung 9: Geédnderte Eintrige fiir die externen Anschliisse

Das Entfernen der Taktversorgung und der externen Anschliisse hinterlasst offene Eingénge
an Bausteinen und entsprechende Fehlermeldungen beim »Design Rule Check« (Run DRCs).
An alle offenen Takteingénge (Eingénge der Klasse » CLK«) ist der externe Takt anzuschliefen.
In Abb. 10 ist fiir den Takteingang des AXI-Busses das Auswahlmenii fiir die Zuordnung des
Taktanschlusses gedffnet. Am Datenbus »microblaze 0 dlmb« darunter ist das Namensfeld
fiir den Taktanschluss noch leer, d.h. der Takteingang ist noch offen.

Name |Connected Port | Direction |Range |Cla$ |IP Type |D‘rﬂ‘e| Sensitivity
B External Ports
e 21 il CLK il |
- Led LEDS::[gpio_0]::GPI0_ 100 £ O ~|[0:7] NONE ~
B- axidite @ 1r axi..
M External Ports j Ciq - I "eHl
- INTERCONNE... proc_sys_reset_O:
- microblze_0_dimb |/ X]
- LMB_CLK 4 CLK
L 8YS5 RST proc_sys_reset 0: :Bus_Struct_Red 1 RST
w- microbize 0 _imb 1 Im...

Abbildung 10: Neuzuordnung des Takts

Insgesamt muss der Takt neunmal angeschlossen werden. Die angeschlossenen Einheiten
und ihre Eingabetakte erscheinen auch als » Connected Ports« in der Beschreibungszeile des
externen Takteingangs (Abb. 11).
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Name Connected Port Direction |Range |Cla$
E-External Ports

proc_sys_reset_0::Slowest_sync_ck 4
microblaze 0 _imb::LMB_CLK
microblaze_0_i_bram_ctrl::[SLMB]::LMB_Clk
microblaze 0 dimb::LMB_CLK

- Ok microblaze_0_d_bram_ctrl::[SLMB]::LMB_Clk I A CLK
microblaze_0::[DLMB:ILMB:M_AXT_DP:M_AXI_IP]::CLK
debug_module::[S_AXT]::5_AXI_ACLK
axidlite_0::[S_AXT CTRL]::INTERCONMNECT_ACLK
LEDS::[S_AXT]::S_AXI_ACLK

Abbildung 11: «Connected Ports« am Takteingang

An der Reset-Schaltung miissen aufler dem Takt zwei weiteren Eingdngen Signalquellen
zugeordnet werden. In einem System ohne Reset-Taste ist das Signal »Ext Reset in« mit
dem logischen Wert null (net gnd) »Reset inaktiv« und der Eingang »DCM _lock« mit dem
logischen Wert eins (net vec) » Taktversorgung synchronisiert« zu verbinden (Abb. 12). Wenn
hier ein Fehler gemacht wird, bleibt der Prozessor dauerhaft riickgesetzt, so dass sich am Ende
des Software-Entwurfs kein Programm starten lasst.

Mame |C0nnected Port | Direction | Range |Class |
= proc_sys_reset (0

- Slowest_sync_clk External Ports::Clk L1 CLK

- Ext_Reset_In net_gnd A1 RST

- Aux_Reset_In A1 RST

- MB_Debug_5Sys_Rst debug_module::Debug_SYS_Rst A1 RST

- Decm_locked net_wvcc 21

- MB_Reset microblaze_0::MB_RESET rie) RST

microblaze_0_imb::SYS_RST

Shes Sl LB ET microblaze_0_dimb::5YS_RST . =
- Peripheral_Reset Lo RST
- Interconnect_aresetn axidiite_ 0::INTERCONMNECT ARESETN Zo RST
- Peripheral_aresetn Lo RST

Abbildung 12: Anschliisse an der Reset-Schaltung

Uber dem rechten grofien Fenster fiir die Systembeschreibung gibt es auker » Bus Interfaces«
und »Ports« einen dritten Reiter » Adresses«. Uber diesen Reiter werden den Speichern und
den Registern der peripheren Bausteine Adressbereiche zugeordnet (Abb. 13). Die automatisch
generierten Einstellungen sind in Ordnung und verlangen keine Nachbesserung.

r: Bus Interfaces | Ports Addresses |

Instance Base Name | Base Address | High Address | Size | Bus Interface(s)l Bus Name Lock

=-imicroblaze_0's Address Map

- microblaze_0_d_bram_ctrl C_BASEADDR 0x00000000  0x00001FFF 8K  ~|SLMB microblaze_0... [
- microblaze_0_i_bram_ctrl  C_BASEADDR 0x00000000  0x00001FFF 8K  »|SLMB microblaze_0... [
LEDS C_BASEADDR  0x40000000 0x4000FFFF 64K |5 AXT axidlite_0 O
~ debug_module C_BASEADDR 0x41400000  Ox4140FFFF 64K = |S5_AXI axidite_0 O

Abbildung 13: Adresszuordnung

Im néchsten Schritt ist die ucf-Datei zu vervollstdndigen. Dazu ist unter dem Fenster mit
dem IP-Katalog der Reiter » Project« auszuwéhlen und im Baum »Project Files« die ucf-Datei
zu 6ffnen (Abb. 14). In der automatisch generierten Datei system.ucf steht nur drin, dass der
Takt eine Frequenz von 100 MHz hat. Die Zuordnungen der Gehduseanschliisse darunter fehlen
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und sind selbst einzutragen. Die Pinzuordnungen der in der Abbildung fehlenden Eintrage fiir
die Leuchtdioden 3 bis 7 sind in der »nexys3.ucf« auf der Web-Seite zu finden. Wichtig ist,
dass die Anschussnamen in der ucf-Datei mit denen der externen Anschliisse des Rechner-
systems iibereinstimmen. Zuordnungsfehler bewirken, dass Schaltungsanschliisse mit falschen
Gehéduseanschliissen verbunden werden. Das wird zum Teil erst beim Programmstart oder der
Programmabarbeitung sichtbar.

Project +08&F %X

1 # automatisch generierte Eintrige

Platform -~ 2

= M=y 1-m — 3 -

=-Project Files 3 NET "Clk" TNM NET = s;:’s_clk_pln, _
-~ MHS File: system.mhs 4 TIMESPEC T3 sys clk pin = PERICD sys clk pin 100000 kHz;
UCF File: data\system.ucf 5
MPACT Command File: etc/dc 6 # selbst zu erganzen
-~ Implementation Options File: ¢ 7 NET "Clk" LOoC = "v10" | IOSTANDARD =
-~ Bitgen Options Fle: etc/bitger 8 NET LOC = "Ulé"™ | IOSTANDARD =
= Ef Files " 9 NET LOC = "V1&" | IOSTANDARD =

i E-microbiaze_0 10 NET LOC = "Ul5"™ | IOSTANDARD =

Abbildung 14: Navigator, Projektdateibaum und ucf-Datei

Die fertige Hardware-Beschreibung steht in der Datei »system.mhs« im Project-File-Baum
direkt tiber der ucf-Datei und kann gedffnet, gelesen und editiert werden (Abb. 15). Von dem
gesamten bisherigen Entwurf geniigt es, die mhs- und die ucf-Datei aufzubewahren (siehe An-
leitungen fiir die Hardware-Erweiterung des Minimalsystems.

Links neben den »Project Files« befinden sich die Icons der Werkzeuge fiir die Schal-
tungserzeugung aus der bis hierher erstellten Konfigurationsbeschreibung. Mit » Run DRLs«
wird der » Design Rule Check« gestartet. Dieser kontrolliert die Konfiguration des Rechnersys-
tems auf Zuldssigkeit. Er erkennt z.B. offene Takt- und Reset-Eingénge. Sind alle mit » Run
DRLs« erkennbaren Fehler beseitigt und wurde fiir alle moglicherweise noch vorhandenen War-
nungen kontrolliert, das sie als ignorierbar gelten!, kann der Generierungsprozess mit » Generate
Netlist«, » Generate BitStream« und »Export Design« fortgefiihrt und abgeschlossen werden.

Navigator € | Project

[ oesign Flow | i |
n
= Pru]ect Files

@ ® MHS File: system.mhs
: - UCF File: data\system.ucf
Run DRCs - IMPACT Command File: etc/download.cmd
- Implementation Options File: etc/fast_runtime.opt

- Bitgen Options File: etc/bitgen.ut
ﬁl% = Elf Files
D H -

- microblaze_0
= Pru]ect Options
- Device: xcbeslx16csg324-2
- Netlist: TopLevel
- Implementation: XPS (Xflow)
- HDL: VHDL
- Sim Model: BEHAVIORAL
De.-jlgn Summary

Generate Netlist

Generate BitStream

6

Export Design

Abbildung 15: Navigator, Projektdateibaum und ucf-Datei

Die Werkzeuge miissen nicht einzeln aufgerufen werden. » Export Design« mit angekreuztem
»Include bitstream and ...« startet alle Bearbeitungsschritte nacheinander (Abb. 16). Mit » Ex-

gnorierte Warnungen bei » Run DRLs« sind oft Ursache fiir Fehlfunktionen bei der spiiteren Inbetriebnahme
und beim Softwaretest. Es empfielt sich, dazu auffindbare FAQ-Seiten zu studieren. Gefahrenlos ignorierbar sind
in der Regel Warnungen, das Lizenzen abgelaufen oder Ausginge ungenutzt sind.
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port only« werden die drei Ergebnisdatein des Hardware-Entwurfs fiir den Software-Entwurf
nur gespeichert bzw. iiberschrieben. » Export & Launch SDK« startet zusétzlich die Software-
Entwicklungsumgebung SDK.

[ Export to SDK / Launch SDK FdEd
@‘ This dialog allows you to export hardware
platform information to be used in SDK.
¥ Include bitstream and BMM file
(¥PS will regenerate bitstream if necessary,

and it may take some time to finish.)

Directory location for hardware description files

| H:\Softprozessor\BSP_AXI Base\SDK\SDK_Export

Export Dnlyl Export & Launch SDK Cancel Help

Abbildung 16: Auswahlfenster fiir den Export

Beim Export und beim Start von SDK ist der Pfad fiir das Software-Projekt anzugeben
(Abb. 17). Das sollte bei einem neuen Projekt ein neu angelegtes leeres Verzeichnis sein.

' Workspace Launcher x|

Select a workspace

Vilelg o le =l H: \Softprozessor\SW_BSP_AXT _BASE

[~ Use this as the default and do not ask again

Abbildung 17: Festlegung des Pfads fiir das Software-Projekt

SDK héngt sich, wenn es so gestartet wird, gern mit einer Java-Fehlermeldung auf. Dann ist
entweder » Export & Launch SDK« noch einmal aufzurufen, aber ohne den Haken bei » Include
bitstream and ...« oder SDK ist direkt zu starten. Abb. 18 zeigt das Icon von SDK und den
Pfad, unter dem es im Startmenii

Start > All Programms
zu finden ist. Beim direkten Start ist der in Abb. 17 festgelegte Workspace auszuwéhlen.

Xiinx Design Tools
ISE Design Suite 14.6

Accessories
ChipScope Pro
Documentation
EDK
& Xiinx Platform Studio
@& Xiinx Software Development Kit

Abbildung 18: Tcon und Pfad fiir den direkten Start von SDK
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3 Uberspringen des Hardware-Entwurfs

Das Ergebnis des Hardware-Entwurfs steht in drei Dateien:
e bit-Datei: Download-File zur Programmierung der Hardware-Funktionalitat
e bmm-Datei: Informationen fiir den Download des Programms und
e xml-Datei: Informationen, die die Treiber iiber die Hardware brauchen.

Fiir den im vorherigen Abschnitt beschrieben Entwurf stehen diese drei Dateien auf der Web-
Seite und sind in ein Verzeichnis auf dem Rechner, z.B. »Download« herunterzuladen. Das
Entwurfssystem SDK ist normal zu starten und in dem sich 6ffnenden Fenster genau wie in
Abb. 17 ein neues leeres Verzeichnis als » workspace« auszuwéhlen. Die Auswahl der » Hardware
Platform Specification« erfolgt iiber

File > New > Project

und dann weiter mit dem Auswahlfenster Abb. 19 und » Next«.

D newproject =TS

Select a wizard

= General
B C/C++
E---[_B Xiinx

------ &4 Application Project
il Board Support Package

8] Hardware Platform Specification

?) = Back I Next = I Firsh | Cancel

Abbildung 19: Festlegung des Pfads fiir das Software-Projekt

Im n#chsten Fenster, Abb. 20, ist die xml-Datei auszuwéhlen. Die Auswahl von »Bitstream
and BMM Files« darunter, erfolgt, wenn sie im selben Verzeichnis stehen, automatisch. Nach
»Finish« wird der Objektbaum fiir die » Hardware Platform Specification« in derselben Weise
wie bei einem Export aus EDK eingerichtet.

ol

Project name: | BSP_AXI_Base_hw_platform

[v' Use default location
Target Hardware Specification
| C:\Users\gkemnitz\Downloads\system.xml
¥ Bitstream and BMM Files

?) < Back et = Finish | Cancel |

Abbildung 20: Auswahl der Dateien zur Beschreibung der Hardware
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4 Software-Entwurf

Nach »Export & Launch SDK« aus EDK bzw. nach »Finish« im Abschnitt zuvor enthélt der
Objektbaum im » Project Explorer« in Abb. 21 den Teilbaum mit den Dateien zur Beschreibung
der Hardware: das bit-File zur Programmierung der Hardware-Funktionalitit, das xml-File mit
den Hardware-Adressen und Konstanten fiir die Treiber und das bmm-File, in dem steht, aus
welchen Block-RAMs der Befehls- und Datenspeicher zusammengesetzt ist.

I x|

File Edit | Source Refactor Mawvigate Search Run Project  Hiinx Tools  Window  Help

Jf‘jv 3w - J@vﬁﬁvgv@vJﬁ;vﬁv%va\JE ﬁ%cfc_,__,_
|26 | & | &~ | el r.ly AP
[t5 Project Explorer 2 = B E'WEE ou B\ @Mal"

= ' - =
B&|¥ {2 Problems fs& Tasks MEI Properljesw B Terminal ﬂ

EH§ BSP_AXI_Base_hw_platform SDK Log G | = & ~ %

= system_bd.bmm
f system.bit :z\Softprozessor\BSP_AXI Base\SDK\SDK_Export\hw\system.xml

g system.xml

Abbildung 21: Projektbaum mit der » Hardware Platform Specification«

Vor dem Entwurf des ersten Anwendungsprogramms ist ein » Board Support Package« mit
den hardware-nahen Funktionen und Treibern zu erzeugen. Uber

File > New > Board Support Pakage

offnet sich das Fenster in Abb. 22. In ihm ist »standalone« auszuwihlen (Entwicklung von An-
wendungsprogrammen, die allein ohne Betriebssystem auf dem Prozessor laufen). Im néchsten
Fenster ist keine der angebotenen Bibliotheken auszuwéhlen. Abschluss mit » Ok«.

1" New Board Support Package Project — |EI |i|

Project name: | standalone_bsp_0|

[¥ Use default location
~ Target Hardware

Hardware Platform: IBSP_A}C[_Base_hw_platform ﬂ

CPU: Imicroblaze_[l ﬂ

~Board Support Package 0S5

xilkernel Standalone is a simple, low-level software layer. It provides access
0 basic processor features ...

@j cec Finish I Cancel

Abbildung 22: Einrichtung des Board Support Packages

Abb. 23 zeigt den Objektbaum mit dem erzeugten »Board Support Package«. Fiir die
Entwicklung der Anwendungsprogramme sind vor allem die Header im Include-Verzeichnis
des Prozessors wichtig. Die hardware-spezifischen Adressen und Konstanten sind hier alle als
Makros im Header »xparameters.h« zu finden. »XPAR _LEDS BASEADDR« mit dem Wert
0x400000000000 ist z.B. die Ausgabeadresse an die Leuchtdioden.
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| Project Explorer £3 = O

>
i

[, system.mss f@ xparameters.h 2

BE|w T

{3 BSP_AXI_Base_hw_platform
=l standalone_bsp_0

i BSP Documentation
é---[& microblaze 0

=5
#define XPAR_UARTLITE_@ DATA_BITS 8 a4
#define XPAR_UARTLITE_© SIO_CHAN -1

|

f'ﬂ==C=(==C=(==C=(==C=(==C=(==C=(==C=(KHKHKHKHKHKHKHKHKHKHKHK

11

/* Definitions for driver GPIO */
@ code #define XPAR_XGPIO NUM INSTANCES 1
RS include
- lb /* Definitions for peripheral LEDS */
- = libsrc #define XPAR_LEDS BASEADDR 0x40000000
----- |5/ libgen.log #define XPAR_LEDS HIGHADDR @x4800FFFF
----- |5/ libgen.opfions #define XPAR_LEDS DEVICE ID @
----- & Makefile #define XPAR_LEDS INTERRUPT_PRESENT @
""" {Hh, system.mss #define XPAR_LEDS IS DUAL @

Abbildung 23: Projektbaum mit Board Support Package und der Header »xparameters.h«

Nach all den vorbereitenden Schritten kann nun endlich die eigentliche Software-Entwicklung
beginnen. Die Einrichtung eines Software-Projekts erfolgt iiber:

File > New > Application Project

In dem sich &6ffnenden Fenster, Abb. 24, ist dem Projekt ein Name zu geben, die Program-
miersprache festzulegen sowie eine » Hardware Plattform« und ein »Board Support Package«
zuzuordnen. Dann geht es mit » Next« zum nédchsten Menii.

Project name: | Haloweld
[¥ Use default location

1ol x|

~Target Hardware
Hardware Platform |BSP_A}G_Base_hw_platf0rm j
Processor | microblaze_0 j
~ Target Software
05 Platform Istandalone ﬂ
Language @ Ci C++
Board Support Package ( Create New |
& Use existing |standabne_bsp_[l j
2 = Back | Wext > | Firfisti I Cancel |

Abbildung 24: Einrichten eines Software-Projekts

Im néchsten Menii, Abb. 25, wird als Vorlage »Hello World« ausgewiahlt und das Anlegen
des » Applikation Projects« mit »Finish« abgeschlossen. Ergebnis ist der dritter Projektbaum
in Abb. 26 mit dem Namen des » Application Projects« und dem »helloworld «-Programm.

Das originale Helloworld-Programm schreibt auf die Standardausgabe den Text »Hello
World« und beendet sich. Die Zeile mit der Ausgabe der Konstanten 0xB3 an die Leucht-
dioden ist manuell eingefiigt. »Xio Out8()« ist im Header »xio.h« und die Ausgabeadresse
»XPAR_LEDS_ BASEADDR« in »xparamerters.h« definiert. Das Ubersetzen erfolgt beim
Speichern. Bei der Fehlermeldung, dass der Ubersetzer »XPAR LEDS BASEADDR« oder
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_lofx
Available Templates:
Let's say 'Hello World' in C. N
Memory Tests
SREC Bootloader =l

@) < Back | et = | Finish I Cancel |

Abbildung 25: Auswahl der Vorlage » Hallo Welt«

»Xio_Out8()« nicht kennt, fehlt entweder die Inculde-Anweisung fiir den entsprechenden Head-
er oder der Pfad zum »Board Support Package«. Im letzten Fall empfliehlt es sich, das » Ap-
plication Project« aus dem Projektbaum zu entfernen, den zugehorigen Verzeichnisbaum zu
16schen und das » Application Project« nochmal richtig anzulegen.

[t Project Explorer 2 = B[ [n xparameters.h w’z
AE|T T #include <stdio.h>
=-{3F BSP_AXI_Base_hw_platform #include “"platform.h”
=2 HalloWelt // Header fir die LED-Ausgabe
--1*,3‘ Binaries #include <xparameters.h>
@) Indudes #include <xio.h>
"'Eb Debug void print(char *str);
== src . .
: ~int main
=-[¢ helloworld.c OF

init_platform();
print("Hello World\n\r");

XTo_Out8(XPAR_LEDS_BASEADDR, @xB3);
return 0;

[¢ platform.c
- [h platform.h

-l standalone_bsp_0 3

Abbildung 26: Vollstandiger Projektbaum und Anwendungsprogramm

Vor dem Start des Programms ist das Bitfile zur Konfiguration der Rechner-Hardware {iber
das Menii

Xilinx Tools > Program FPGA

in den Schaltkreis zu laden. Dabei 6ffnet sich das Menii in Abb. 27, in dem nur »Program«
anzuklicken ist. Falls der Download nicht klappt, ist zu kontrollieren, dass die Baugruppe Strom

40 Program FPGA x|
~Hardware Configuration

Hardware Specification: H:\Softprozessor\SW_BSP_AXI_BASE\BSP_AXI Base hw_platform\system.xml

Bitstream: | H:\Softprozessor\SwW_BSP_AXI_BASE\BSP_AXI_Base_hw_platform\system.bit Browse.. |

BMM File: | H:\Softprozessor\SW_BSP_AXI_BASE\BSP_AXI_Base_hw_platform\system_bd.bmm = Browse.. |
~Software Configuration

Processor | ELF Fie to Initialize in Block RAM |

microblaze_0  bootloop |

@:l Program I Cancel

Abbildung 27: Programmieren der FPGA-Hardware
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T Run Configurations x|
3= =+
SRER NS Name: | HalloWelt Debug
[ type fitter text Main . Device Inftiaizatio| - STDIO Connection|
~[E] C/C++ Application C/C++ Application:

...... [c] C/C++ Remote Application

| Debug\Hallowwelt.elf

------ = Launch Group

----- $#7 Remote ARM Linux Application Project:
[E Target Communication Framework ||| [ Halowelt Brows
=& Xiinx C/C++ application (GDB) ) )

£ Halowet Debug Build (if required) before launching

) Build configuration: |Debug

Abbildung 28: Grundeinstellungen der » Run Configuration«

hat, angeschaltet und das Programmierkabel angeschlossen ist. Manchmal helfen auch mehrere
Versuche, abziehen und wiederanstecken des Programmier-USB-Kabels und vor allem Geduld.
Abschliefsend ist {iber das Menii

Run > Run Configurations..> »Xilinx c¢/C++ applicatiion (GDB)

mit einem Rechtsklick auf »Xilinx ¢/C++ applicatiion (GDB)« eine » Launch Configuration« zu
erzeugen. Unter dem Reiter » Main« bekommt diese einen Namen, ein Projekt, ein ausfiihrbares
Programm, ... zugeordnet (Abb. 28). In unserem Projekt ist nur unter dem Reiter » STDIO
Connection« eine Anderung erforderlich (Abb 29). Hier ist » Connect STDIO to Console« und
als Port » JTAG UART « auszuwéhlen.

Name: | HalloWelt Debug

(12 Main [%~ Source [~ Device Initialization |- STDIO Connection
[+ Connect STDIO to Console

e il TAG UART [

Abbildung 29: Verbindung der Standardausgabe mit der Konsole

Der Programmstart erfolgt mit » Run« bzw. iiber die Schaltfliche @. Nach Laden und Pro-
grammstart gibt unser Beispielprogramm auf der Konsole den Text »Hello World« aus (Abb.
30). Das Ausgabebitmuster auf den Leuchtdioden ist »1100 1101« (der bitgespiegelte Wert zu
0xB3).

El Console 3 v Tasks}@Term'lnal ﬂ it Problems] o Executabﬁ] X %| xellgeE| B0
=<terminated= Test1.elf [Xiinx C/C++ application (GDB)] H:\Softprozessor\SW_BSP_AXI_BASE\Test1\Debug\Test1.elf [Console connected to JTAG UART]
| Hello World 4]

Abbildung 30: Testausgabe auf der Console



